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Platform Trading Forex MetaTrader

http://www.belajarforexpro.com memperkenalkan platform trading MetaTrader yang menawarkan
beberapa fitur canggih yang didesain untuk meningkatkan performance dalam Trading Forex.
Menggunakan teknologi tinggi, program ini memiliki interface yang simple dan mudah digunakan
sehingga trader dapat memonitor transaksi yang mereka lakukan serta melakukan analisa menggunakan
indikator-indikator yang tersedia dan melakukan pengembangan strategy secara lebih efektif.

Meta Trader adalah salah satu platform terbaik di dunia yang dirancang untuk profesionat pada
transaksi Forex & CFD. Saat ini, lebih dari 100 perusahaan breker dar’ bank-bank di-seluruh dunia telah
memilih Meta Trader untuk mengakomodasi dan memenuhi standar kinerja bisnis yang tinggi.

MetaTrader juga menyediakan fasilitas trading otomatis yang dapat diprogram menggunakan Bahasa
Pemrograman Meta Quotes Language (MQL) Menggunakan bahasa ini, anda dapat membuat Expert
Advisor, Custom Indicators dan Scripts. Expert Advisor (Forex Robot) dapat menganalisis situasi di
pasar, membuat keputusan, menempatkan pending order, menutup posisi, dan membuka posisi tanpa
ada partisipasi trader.
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PANDUAN INSTALASI METATRADER

=> Setelah melakukan download software trading MetaTrader pada broker yang digunakan, klik 2x
pada file setup

MT45ETLP

=» Pilih bahasa yang anda inginkan, lalu klik Next
=> Tick / centang “Yes, I agree with all the terms of this iicense agreement”, klik Next

el MetaTrader 4.00 setup

MetaTrader 4

Client Terminal

MetaTrad er

Client Terminal

Please closely read the following license agreement. Do pou accept all the terms of the following
licenze agreement?
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=>» Folder instalasi MetaTrader tidak perlu diubah (default), klik Next
=>» Program Group tidak perlu diubah (default), klik Next

& MetaTrader 4.00 setup

MetaTrader 4 % :‘

Client Terminal

.."E-"-r MetaTrader 4.00 setup -

MetaTrader 4

Client Terminal

Select program group:

Sedect the destination folder where yau want 1o install MetaTrades .00 To install b & diffesent
lecation, chok Browss, and select anolher foldes, Accessones
ALCD Spstems
activePDF
Instalation foldst iggﬂér:stratlve Tools
C:\Piogram Fie-z\MslaTiadald B, Apachg Friends
e e - Canon i255

R} Cieative
Fucast Pro 4
F=<DD - Melalrader 4
F«Pro 2 MelaTradel
FuPro ietalrader |
| Gadwin Systems ]

MetaTrader 4 I i
| St |

— Mataluates Saflwaie Cop

I < Back |[ Nes > || Cancel ] [ < Back J[ Mext » ][ Cancel ]

=» Mengisi data personal pada instalasi MetaTrader pertama kali & pendaftaran Demo, tick "I agree
to subscribe to your newsletters”, lalu klik Next

=> Klik Next. (Untuk accouint Demo, jika seiver ada lebih dari 1, silahkan klik Scan lalu pilih server
yang ping timenya semakin kecil)

otz A\ A\ S P

Fersonal datails
To open an accour, please fill out 2l the following islds

Trading Servers
Select 3 more suitable trading server:

Name: |BelajzForaxPro | Address Company Ping
- e ———— ¥ EuroOrient-Dema EuroOrient Securties&Financial Services Ltd
Courtry: |Indonesia v| State: |Jakarta |
City: |Jakarta Zip code: |12345
Address: |Jembatan Tiga |
Phone: 38023570 Email: |support@belajarforexprolcom
Account Type: |Demn-USD v Cumency; |USD
Leverage: | 1:500 v‘ Deposit: |100000 w/

| paree to subscribe to your newsletters [ :

Scan
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=» MetaTrader akan menggenerate Nomer Login dan Password untuk account Demo. Klik Finish

Open an Account

i PO Investor adalah password yang dapat digunakan
login dan melihat trading, tetapi tidak dapat
Name: BearFerasPo melakukan intervensi. Investor password berguna
ot hon et ol untuk menunjukkan performance trading kepada
oo orang lain.
[ [TTT!
Login: 577453 Ingat data login number dan password di atas adalah
Fesor aaBoowd untuk Demo Account
Investor: uSsnpey {read only password)
Please keep your usema me and passwords in a safe place.
Finish % [ concel |

=» Setelah klik Finish, secara otomatis MetaTrader akan melakukan login ke Demo Account yang baru
saja dibuat.

=>» Untuk membuat account Demo lain, silahkan mengulang langkah sebagai berikut :

Klik Tah File => Open An Account atau Alt-F lalu A

LOGIN LIVE ACCOUNT

=» Bila anda telah memiliki Account Live dan ingin melakukan login. Silahkan melanjutkan dengan
langkah sebagai berikut :

Klik Tab File => Login atau Alt-F lalu L



FxPro MetaTrader 4 Untuk login ke Account Live, setelah anda mendapatkan

DB authorzaton alows o get access o the e account Nomer Login dan Password dari Broker, masukkan Nomer
i Login dan Password pada kolom seperti gambar di samping,
togn: 07364 ¥ lalu mengganti Server ke Server Real, klik Login
Password: | ooooooooo
| — ¥ | Password MetaTrader merupakan gabungan huruf besar,
ST - | huruf kecil, dan angka, sebaiknya anda Copy Paste agar tidak
Login \ Cancel I Sa |a h .

FUNGSI DARI ICON-ICON METATRADER

Buka Chart Baru (New Chart)

Window Price / Market Watch (Ctrl-M) * Demo Account (Account Real tidak mencantumkan
" tuiisan Demo Account)

Window Navigator (Ctrl-N) * /! AutoScroll *

Window Terminal (Ctrl-T},*” GBP/USD 1 Minute

Open Order A Icon | Chart : Bar, Candlestick, Line

. §

%% 368555: ‘ @ '!cccruntb- [GBPUSD,M1]

Insert \Qhaﬂs \Tnuls ingbw—HeER

BB (8 ) B G rerose § B oo 1[0 1

.........

| a|p Lk G QB

!; +~ | = 7 # AT %e :M\l ME MIE M0 HI H4 DI Wit MM

/ |\ Membuat trénd.line Time Frame /
Membuat garis horizonta Strategy Tester Zoom In/Out  Indicators
Membuat garis vertikal Fibonacci Retracement

Penunjuk harga pada titik tertentu MetaEditor

* Penting



: MetaTrader - - [GBPUSD. ,M1] ;

T Fle [Vya| et Chats Tooks _ _ - - Window 1 : Market Watch (Ctrl-M)
@v %, | &) @ e =l %New[}rder '/_i>' ‘% ExpertAdvrsnrs: IE ]E‘ B | Q Q JL Lk | @.v ®v v .« . .

Ik == | = 7 @ At Wi M5 Mis M3 ML He DL i N BerISI harga Sekarang (Bld / ASk)’
ms&&“fﬂ: —= : o ‘_ GBPUSD. M1 14641 1.4841 1.4840 1.4880 p da N

Symbol Bid Ak High Low ®-[#] Indicators ) - - 3 - - 3 - - 3
| EURUSD. 17933 12935 L2990 12875 | = 8 ExpertAdvisors
Q’ GBPUISD. 1.4840. 14843 14872 14701 i Pd

{4k USDIRY, 2152 91,59 9%39 90.89 P g
| P MACD Sample
4 USDCHF. 1.1643 1.1646| 1.1678 1.1585 : % i
% Moving Average
| 4 USDCAD. 12282 L2286; 12297 12130 P
| F I ‘% Super_Hedging_Aw
| & AUDUSD. 0.6717 0.6720| 0.6765 0.6626

| : ‘%”) Super_Hedging_Aw
|® NZDUSD, | 0.5320 0.5325 0.5334 0.5242 € super_Hedging_Sin

Window 2 . Navigator (Ctrl-N)
Berisi List Account (Demo & Live),

| & GepcHE. 17280 L7287 17297 17086 % super_Hedging_Sin I fi - e E o g A P d S . t
|'® GBPIPY, 13589 13596 137.35 13563 || - Super Hedging Sin - NAICaTOol v XDEI (g (]VISOF, an Scrl p
E& EURALID. 1.9247| 1.9257| 19443 1.9137 i 2 Super_Hedging_Sin

| - ‘% Super_Hedaging_Sin

! %test_broker
& [%) Custom Indicators

& 5 soits v e 2 f
|| Symbols | Tick Chart | (|L_common | Faverites | _’ EURUSD.,M1 | GBPUSDMI | e
= é]rd“er / Time 'IZYiJE- 5‘.\‘25‘ S:jmia.oi .Pﬂce- SfL T‘,".P P‘nr‘:t= Crmrn‘;‘f‘ss... -5;1.'ap 7mi“|f.
a 9672519 2005,02.09 11:28 buy 100 abpusd, 1.4840 1.4660 1,5005 L4740 .00 .00 0.00
a 9672725 4 2009.02.09 11;32 sel 2.00 gbpusd. 1.4813 1.5000 1.4553 1.4843 0.00 0.00 -500.00
Q 9674227 2009,02,09 12:14 buy 3.00 gbpusd, 1.4855 1.4560 1,5005 1.4840 0.00 0.00 -450.00

!-::; @ Balance: 286 B17.00 Equity: 285 767.00 Margin: 1 187.08 Free margin: 284 579.93 Mzrgin levek 24073.10% -1 050.00
=

3| Trade | AccountHistory | News | Alerts | Malbox | Journal |

For Help, press F1 | Default | | | | LT 108/0 kb

Window 3 : Chart

Chart dapat dibuka beberapa sekaligus dengan time frame dan pair yang berbeda. (Klik Tab File =>
New Chart atau Kiik Alt-F, ialu N). Sebagai contoh [GBPUSD, M1] pada gambar di atas menunjukkan
chart yang sedang aktif adalah Chart GBP/USD timeframe 1 menit (pada kiri atas chart tampak
GBPUSD, M1 atau tab GBPUSD,M1 berwarna putih).

Window 4 : Terminal (Ctri-T)
Window untuk mengecek

, , Alert (Alarm jika harga telah
menyentuh titik tertentu), Mailbox (berita / pengumuman dari Broker),
MailBox sangatlah penting untuk sering dicek apabila ada perubahan peraturan dari Broker!
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Window Market Watch
adalah window yang menunjukkan Harga Sekarang (Bid/Ask), dan High Low. Untuk subscribe
Harga High dan Low, silahkan klik kanan mouse pada Market Watch, lalu

pilih High/Low Jam Server (tidak berjalan berarti Server Broker Off atau tak ada koneksi)

Market Watch: 23:59:51 - K 5 B
@ e Mew Crder F3
Symbal Bid  Ask High Low || A
@ EURUSD | 1,203% | 1,20426| 129938 1.27470 _ Egp Chat Window
% GBPUSD | 1.47847| 1.47897| 1.43425 1.45882 | | - & 189385: [l Tick Chait Space
# USDCHF | 1.16169| 1.16219| 1,17439 115810 g ;?4;25
- £ ! ! ! b e P 3 A }
# USDIPY | 91354 [91.884 92.205 50.730 L o e -
$ AUDUSD | 0.67540 [0.675%0| 0.68015 0.64756 /& 277108:1 Hide &
¥ USDCAD | 1.21896 | 1.21986| 1,25392 1.21864 - & 292498: BelajarForexPro _ Show Al
@ NZDUSD | 0.53245| 0.53295| 0.53635 0.51092 & 298789: BelajarForexPro
a 354754 BelajarfaorexPro | Smbuls
Klik 2x di tabel untuk @ 2 el | Sets .
" & 358555: BelgjarForaxPra '
melak.Ukan Ol’del' &} 356459 expert B
W|nd0W NaV|gat0r &b 506343 BelajarForexPro | v High/low % |
T a 3 Time
Account Demo (hijau) // L & 577453 BelajarfarexPro
/,_—Laf[?j Irdicators v Auto Ararge
. . — |8 Expert Advisors :
_— T W Grid
List Indicator | & [ customIndicators
. P _— LT :
List EXpert Advisor— B ?f,'":': BB Fopup Prices F10
///// o gy CIOSE
Window Terminal
xi \}der / Time Type Size | Symbaol Price

History Closed Position/Deposit
/Withdrawal
Berita / News Ekonomi Terbaru

Alert untuk pemberitahuan harga
/telah menyentuh titik tertentu
Mailbox yang berisi pengumuman

Account History | Mews | Alerts | Mailbox——Soomat—— dari Broker (Pentlng)

 Balance: 117 395.09 Equity: 117 393.09 Free margin: 117 393,09




dem . Penggantian setting yang berhubungan dengan chart
Bt Ao — dapat dilakukan dengan cara : Klik kanan mouse pada

li7| Indicators List Cha rt
Periodicity

Bk & QD k| G
o il MM

all | GEPLISD,MI1 1.49301 1.49311 1.45300 1.49310

LS Template

B o Trading :
e e e ll New Order (F9) : Open order pada harga market (saat
| BN ini)
ll Bila titik tempat anda klik kanan pada chart lebih tinggi
@ dari harga sekarang, akan muncul pilihan Buy Stop dan
Sell Limit.

Vilumes

., Zoom In
Zoom Out

Y Save As Picture ..
l [~ Print Preview

ALy Print...

i Properties...

Expert Advisor (EA / Robot / Program Trading) :

pilfl 5 Feb 2008 9 Feb 18:37 9 Feb 18143 9 Feb 18:59
EURUSD M1 | USDIFyY, M15 GBPUSD,M1

Ingat, tidak semua EA dapat berjalan bersamaan pada beberapa Chart yang berbeda ! Pastikan anda
memahami karateristik EA agar tidak terjadi konflik yang dapat mengacaukan kerja EA.

Indicater List (Ctrl-I) :
List indikator apa saja yang sedang aktif pada chart tersebut

Periodicity :




Template :
Chart dan setting indicator favorit dapat disave dalam bentuk template, dan dapat diload kapan saja.

Grid :
Setting untuk menampakkan garis horizontal dan vertikal pada chart tersebut

Volumes :
Setting untuk menampakkan grafik volume trading pada chart tersebut

Zoom In / Out :
Setting zoom untuk memperbesar / memperkecil grafik harga pada chart tersebut

Save as picture :
Save chart dalam file gambar (gif atau bmp)

Print :
Untuk melakukan print chart tersebut

Properties :
Setting untuk mengganti warna glemen chart, menunjukkan garis Ask, Open High Low Close (OHLC),
dll
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STATUS KONEKSI INTERNET (STATUS BAR)

Status koneksi internet dapat dicek pada grafik sebelah kanan bawah software MetaTrader.
i Mo connection HHHTT 348/1kb i 187/0kb

» No connection (Grafik merah) menunjukkan bahwa koneksi internet terputus / tidak ada koneksi

> (Grafik merah) menunjukkan nomer login atau password salah. Ataupun account
tidak ada (dihapus)

» Warna grafik hijau full menunjukkan koneksi ke datacenter

» Warna grafik hijau dan merah menunjukkan koneksi langsung ke server MetaTrader (Ctrl-O =>
Server => Hilangkan tick / centang pada “Data Center auto configuration”)

Troubleshooting -

Bila grafik koneksi teiah menunjukkan minimal warna hijau merah atau
hijau full tetapi pada chart selalu muncul “Waiting for Update” selama
lebih-dari 10 menit, kermungkinan problem ada pada server broker
yang memisahkan account menjadi 2 jenis yaitu, standard dan micro.

Untuk mengatasi masalah chart yang selalu tidak update, silahkan (buka chart baru)
dengan cara klik Tab File => New Chart atau Alt-F, lalu N. (Ingat bukan Tab File => Open Deleted,
tetapi Open New Chart !).

Hics Al Bila hanya ada sedikit pilihan currency pair yang nampak, sebelum Open New Chart
[Csevs | silahkan kiik kanan mouse pada Window Market Watch => Show All.

Symbols

Sets

Setelah open new chart, ketika diperhatikan akan L e a
nampak sedikit perbedaan chart yang baru anda buka tersebut — - -
dengan chart default. Misalnya GBPUSD.,M1 dengan defaultnya o o T
GBPUSD,M1. (Sebagai contoh perbedaan ada pada tanda titik setelah pair GBPUSD).

1n




Jika chart baru sudah ditambahkan dan tetap muncul *Waiting for Update” atau jam server pada
Window Navigator TIDAK BERGERAK, klik Ctrl-O => Server => Hilangkan tick / centang pada “Data
Center auto configuration” hingga “Waiting for Update” hilang dan jam server normal kembali.

e @l Setting server yang terbaik dan wajib bagi
oo |Chumi] Qi) Tt | Bt Advioes ] v, | Pt | Everts] pengguna Expert Advisor adalah selalu
| menggunakan koneksi langsung ke server
Orient-Real 1 - EuroOrient Securties&financial Services w . ~e 5 \
] s s T MetaTrader (tanpa melalui datacenter).
% Center auto configuration . . .
Deta Centet /57 | Klik Tab Tools => Options => Server. Hilangkan
[] Enable proxy server From tICk pada
Keep personal settings and data at statup
Enable DDE server _PL'{FI N G_
+| Enable news . Lot .
Setting seperti ini sangat disarankan untuk

[ ok J[ s J[ = 1| menghindari chart tidak update yang ditandai
dengan jam server pada Window Market Watch

tidak bergerak.

Sering-seringiah mengecek jam server di Window Market Watch! (Jika chart tidak update
maka dapat berakibat sangat berbahaya bagi trader yang menggunakan Expert Advisor / Robot)

Koneksi menggunakan DataCenter :

—Untuk mengganti Server MetaTrader, silahkan klik grafik koneksi, lalu pilih server
iy yang anda inginkan. (Jangan diganti bila tidak perlu !)
raiding . - -
FX Trsdng DC1 MetaTrader dapat melakukan pencarian server secara otomatis. Klik Rescan
R Eal o )| Servers untuk melakukan hal ini.
Fx Traiding DC5 - Hong Kong
FX Traiding DC2 - Hong Kong
FX Traiding DC3 - Live for Saudi Arabia
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MENGGANTI PASSWORD METATRADER

=» Untuk mengganti password metatrader, klik Tab Tools => Options atau Ctrl-O

=» Pada Tab Server klik Change. Beri dot pada Change Master Password untuk mengganti password
utama atau dot pada Change Investor (read only) password. Investor password adalah password
untuk diberikan kepada investor / orang lain agar mereka dapat mengecek account mereka tanpa
dapat melakukan intervensi (hanya read only password)

=» Current Password isikan password lama yang ingin diganti.

=» New Password isikan password baru.

=» Confirm ketik ulang password baru

[ chanse Passpia \) )\ A\ N~/

|I%@‘j Password must be compiex enough, at least five symbols long and at least two of
Ib'

Server |) arts_I -Objects_ii_dee |!.Expert Advisors. I Email | -F‘ublishe;i,_E\rents!

the three character types present - lowercase, uppercase, digit

x|
ange \’ ‘ K\
— by I Login: | 73527

~| Tes] Current password: | password lama | must be the master password
4 _—~Mengganti password MetaTrader

{\ Py (% Change master passwar
(") Change investor (read orr% password

Enable DDE er .
Enable serve Mew password: | password bary | Confirm: etk ulang password bar:'p
W 30Ie News i x :

[ OK j [ Cancel ]

[ ok ][ canced ][ Hep |

Password harus minimal 5 karakter, menggunakan kombinasi huruf besar, huruf kecil, atau angka.
Contoh : Abcde (gabungan huruf besar dan kecil), abc12 (gabungan huruf kecil dan angka),
ABC12 (gabungan huruf besar dan angka), atau Abc12 (gabungan huruf besar, kecil, dan angka)

Apabila password telah sukses diganti, maka akan muncul keterangan penggantian password telah
sukses pada Window Terminal => Tab Journal

13



: MetaTrader -

- [GBPUSD.,M1]

Untuk menambahkan indikator

I'}ﬁ File Vi Ingert [} Chais Tools  Window Help . .

: —— teknlkal, klik Tab Insert =>

G r/hdlcators Aecelerator Dscillator I L ey Q @ L 1| Lﬁﬂ. o~ . .

- : Accumuation/Distrbuton Ind icator, Lines, Channels, dll
Lines L4 DLWl M

| Gl Channels ] Agitar Wl | GEPUISD, M1 14942 14947 1,4933 1.4934

_ Symbol G i Awerage Directional Movement Index

| & EURLSD. ) _ Awerage True Range

| Fibonacci L4

| 4 GEPUISD. " Awesome Oscillator |

| & usDIRY. Shapes e -

| & UsDCHE, Arowe 3 Trend Awerage Directional Movement Index | [

: 3 Bolli Band

| ¥ USDCAD, 4 Andrews’ Pichfork Oscillators olinger Bands

l 1 Volumes 3 Commadity Channel Index

| ] Cyce Lines

f £ NZDUSD, Bill Williams 3 | Moving Average

|2 GapcHF A =t

| 3 s Custom 4 Parabolic SAR

| & GBPIPY. T Test Label : -

. 4 EURALID 1.9137| 1.9147| 1.9443 l 1.9108 : % Maving Average B uin) Pevics

| - F e reioes | |V IIDNNEN

Klik kiri mouse
pada Tab Account
History, lalu klik
kanan mouse pada

tengah Window t{}
Account History |
Symbols | Tick chart | | [T
order ;| <
|[e] 1033... 2608
3 1033... 2008
03w, oo

([ 1o85.. 008
(3 1085... @- o
[d 1o8s... 2008 v

2008.11.27 09:00

All History
Last 3 Monthz
Lagt Month

Custorm Period...

Save as Hepoit

Save as Detailed Heport

Commissions
Taxes
Comments
Auto Amange
(Grid

|:a 1087... 2008.11,27 09:33 buy 0.10

Klik Tab Account History lalu pilih Periode History untuk melihat
histery transaksi Trading / Deposit / Withdrawal pada waktu tertentu.

All History : untuk menampilkan semua history transaksi
Last 3 Months :

Last Month : untuk menampilkan history transaksi bulan lalu
Custom Period :

Save as Report : untuk save history transaksi (dalam format html)

Trade (AccountHistory ) Mews | alerts | Malbox | E

1



Save as Detailed Report : untuk save history transaksi secara mendetail (dalam format html)
Commissions : untuk menampilkan komisi yang dicharge broker

Taxes :

Comments : untuk menampilkan komentar misalnya pemberitahuan stop out / so (Margin Call),
komentar dari Expert Advisor, dana tak cukup, dll

MELAKUKAN ORDER PADA METATRADE

Untuk melakukan order

o Symbol: (GBPUSD., Great Eritain Pound vs US Dollar) | S!Iahkan kiik /ZX pada pasangan
\‘ N’“fw\ Yo LR 14536 Volume: 1.00\—\4—/<h . .
= m e oo mg\.a uang (pair) dalam
o Comment: | | Window Market Watch
Lo Type: |Inst3ntExecution \f:\\
L e P 81 Pair default dapat diganti jika
oy s P——;-i_ﬂf NS ] anda ingin mengubah pair
o ' oy / ~ \\ \ Buy ]
Klik 2x pada pair yang i — Sewaktu Ordel‘
diinginkan atau tekan ‘14538
FS untuk melakukan []Enable maximum deviation from quoted price
Ord ; 1452
“ %th%,::lﬁw Maximum deviation: | pips

Cara alternatif adalah klik F9 untuk melakukan order pada chart pair yang

Contoh : Saat itu yang sedang aktif adalah chart untuk pair GBP/USD, maka jika
anda klik F9 defaultnya adalah order untuk pair GBP/USD. Meskipun demikian,
pair tetap dapat diganti sesuai pair yang anda inginkan pada Window Order.

GBPUSD. M1 [ J5AR1ISD. M1 | GBRPUSDML |

19



Setting pada Window Order :

GEPUSD, Symbal: iGBPUSD. , Great Britain Pound vs US Dollar v |

volume: | 1.00 v . H H
o rl—lo.m T rara oS Symbol : mata uang / pair yang diorder

Comment: | |

Volume : jumlah lot dari order. Contoh :
1, 10, 0.1, dll (menggunakan titik untuk
desimal, bukan koma!)

Type: | Instant Execution

Instant Execution ending Order

Stop Loss : harga stop loss

(|| e it i i e ite (mengguniakan satuan harga, bukan point
R s I contoh : 1.4820)
Take Profit : (menggunakan satuan harga, bukan point ! contoh : 1.4875)

Comment : Komentar untuk menandai order {tidak hairus diisi, bisa dikosongkan
=~ e \ ’

Type : Tipe dari order, ada 2 type order yang penting, yaitu Instant Execution dan

Instant Execution (defauiit) : Order pada harga market saat itu (Bid 1.4832 / Ask 1.4835).
Untuk toleransi ketika ada slippage / terjadi selisih antara harga yang didapatkan dengan harga yang
diorder silahkan tick Enable maximum deviation from quoted price, lalu masukkan jumlah pip toleransi.

Langkah melakukan order pada harga sekarang (Instant Execution):
1) Klik 2x pada pair yang diinginkan di Window Market Watch atau klik F9,
2) Isi kolom Volume dengan jumlah lot, gunakan titik untuk desimal (contoh 0.1)
3) Isi kolom Stop Loss dan Take Profit (tidak harus).
4) Pilih Type Instan Execution
5) Tick Enable maximum deviation from quoted price jika perlu
6) Klik Sell atau Buy (Ingat Buy mendapatkan harga Ask, Sell mendapatkan harga Bid).
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‘GBPUSD,

-t L4BTE

1.4851

Symbol: iGBPUSD., Great Britain Pound vs US Dollar

Volume: | 1.00 R
Stop Loss: 0.0000 ¢| Take Profit: | 0.0000 &
Commen t: | |

Type: ([Pending Order )

v

Pending Qrder

Type: |l GBPUSD. 1,00

atprice: | 0.0000 % | [L Place.

Expiry: E 2/10/2009 14:15

Qpen price you set must differ from market price by at least 10 pips.

Pending Order : Order pada harga selain
harga market saat itu. Sebagai contoh
harga sekarang 1.4832. Untuk order g/
atas atau di bawah 1.4832, silahkan
menggunakan Pending Order.

Order Buy di atas harga Ask sekarang
1.4835.

Sebagai contoh order Buy pada harga
1.4850, Pending Order => Buy Stop

Order Buy di bawah harga Ask sekarang 1.4835. Sebagai contoh order Buy pada harga 1.4820, Pending

Order => Buy Limit

Order Sell di atas harga Bid sekarang 1.4832. Sebagai contoh order Sell pada harga 1.4850, Pending

Order => Sell Limit

Order Sell di bawah harga Bid sekarang 1.4832. Sebagai contoh order Sell pada harga 1.4820, Pending

Order => Sell Stop

At Price : Harga pending order yang diinginkan. Sebagai contoh bila anda ingin order Buy pada harga
1.4850, silahkan isi'1.4850 pada at price

Expire : Masa berlaku pending order (tidak harus diisi). Jika anda isi, maka pending order akan
dibatalkan (cancel) ketika telah expire (kadaluwarsa).

11



Langkah melakukan Pending Order :
1) Klik 2x pada pair yang diinginkan di Window Market Watch atau klik F9,
2) Isi kolom Volume dengan jumlah lot, gunakan titik untuk desimal (contoh 0.1)
3) Isi kolom Stop Loss dan Take Profit (tidak harus).
4) Pilih Type Pending Order, Pilih Type Pending Order Stop atau Limit
5) Isi At price dengan harga Pending Order
6) Isi Expire (jika perlu)
7) Klik Place

Penting :
Pada bagian bawah Expiry ada keterangan : “Open price you set must differ from market price by at

least 10 pips”. Hal ini dapat menjadi acuan bahwa Pending Order, Stop Less, dan Take Profit harus
berjarak minimal 10 point dari harga sekarang ! Pesan Error Invaiid S/L or T/P adalah dikarenakan
setting stop loss / take profit yang lebih kecil dari batas minimum yang diperbolehkan oleh broker.
Setiap broker memiliki peraturan jarak minimal yang berbeda i

Order Open ataupun Pending Order aktif akan nampak pada Window Terminal dalam Tab Trade.

Order + I Time | Type|  Sze  Symbol Price | s/L TP Price
[[3 19795713 2005.02,10 10:44 zel 0.10 abpusd 143464 1,50254 145964 1.4839nl/
[#| Balance: 117 339.75 Equity: 117 407.19 Margin: 29.69 Free margin: 117 377.50 Margin level 395406.26% Balance
[ 19795720 2009.02.10 10:44)  buy stop 0.20 gbpusd 1.48724 145934 1.50224 143390 —

- Accoont History | Mews | Alerts: | Maibox | Experts | Journal |

Order yang sudah ditutup ataupun Pending Order yang telah dicancel akan nampak pada Window
Terminal dalam Tab Account History.
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_ Order 7 Time Type Size Symbol Price S/L T/P Time Price PrOﬂt/ LOSS adalah total
| 1979... 2009,02,10 10:31  buy stop 0.20 gbpusd 1.48951 1.47183 1,50451 2009.02,10 10:32  1.98676 -

L untung / rugi selama

(3 187... 2009.02.10 10:44 sel  0.10 gbpusd 1.48454 1.50254 1.45964 2009.02,10 10:49 . 1.48230 | )

B 1979 009.02.10 10:44  buy stop 0.20 gbpusd  1.48724 1.45934 1.50224 2009.02,10 10:49 ) 1.43230 perIOde yang anda set

pada setting Account

Mews | Alerts | Mailbox | Experts | Journal |

History

Pada gambar di atas, order Sell 0.1 lot GBP/USD open pada harga 1.48464 pukul 10.44 waktu server
dan close pada harga 1.4823 pukul 10.49 pada hari yang sama yaitu 10 Februari 2009

Penjelasan lebih lengkap mengenai cara perhitungan Volume (lot), Perbedaan Tipe order Buy Stop, Sell
Stop, Buy Limit dan Sell Limit, Cara setting Stop Loss, Take Profit, Trailing Stop, dan dasar trading forex
lainnya dapat dibaca di http://www.BelajarForexPro.com/tutcrialforex (Indoresia) atau

http://www.BelajarForexPro.com/tutorialforex en (Enalish) (Penting dain harus dibaca oleh pemula!)

Symbols | Tick

I 19802554

New Order )

Cloge Order e

T

L

v

Modify or Delg@%rder

Trailing Stop

-

Profit *

Ceinmissions
Taxes
Comments
Auto Arange A
Grid G

| [s] Balanee: 117 423.19 Equity: 117 413.89 Ma

||l [4 19802700

2008.02,10 11:15

a Trade |) AccountHistory | News: | Alerts: | Mail

Cara melakukaii closing H

Klik Tab Trade pada Window Terminal, klik kanan mouse pada order yang
akan diclose, pilih Close Order.

Klik kanan mouse pada open order
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[ Order #19802700 buy 0.20 GBPUSD at 1.47910 st: 1.45970 tp: 1.49410) B Setelah itu nampak window Order lalu

Symbal: [ G8PUSD, Brtsh Pound vs Us Dolar vl | klik button Close (kuning).
vome: 00 v
o @ —— | Apabila harga bergerak cepat sewaktu
Type: [Instant Executon | | proses closing, akan nampak konfirmasi
" et eaton requote. Artinya harga telah berubah
1.47936 / 1.47962 dan apakah anda ingin ciose pada harga
5 G = 1 | yang baru, jika ya siizhkan close, jika
\ | S—TTTTT T tidak bisa anda cancel.
M /'_| Enablema)tlmumdevlah:onﬁom c.suc?tedprice - \ \
b e e B Untuk mengurangi requote pada saat

" harga bergerak cepat, silahkan tick
Enable maximum deviation from quoted price. Lalu set toleransi deviasi dalam pip

= | Cara meiakukan edit Stop Loss / Take Profit o
Cloge Onder
EL Modfy or Delste Order ,}J Klik Tab Trade pada Window Terminal, klik kanan mouse pada order yang
Trafing Stop » |akan diclose, pilih Modify or Delete Order.
Profit 4
| Codiricsione Ingat untuk order yang sudah open, tidak dapat diedit harga open dan
Taees jumlah lot, tetapi hanya dapat mengedit level Stop Loss / Take Profit!
SYmbolsm; Efﬂmm:rrts : FL
_ — 4 o Amange A =

lik kanan mouse pada order untuk mengedit
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Qicler#19502634.5211.0.10 GBRUSD o 147635 1: 149440 10:.1:46000 B Setelah itu nampak window Order. Ganti
——— Stop Loss dan atau Take Profit jika perlu,
e w1 | lalu Kiik button Modify (merah).

Comment: | |

o Momd“"e’ ok *' | Pada contoh di samping ada peringatan :
Stop Loss or Take Profit you set must differ
from market price by at least 50 pips.

GBPUSD

Umumnya sangat jarang broker yang
memberikan/jarak minimal 50 pips. Karena
ity silahkan mengecek ulang pada broker
anda. Jika platform broker memiliki tambahan 1 digit di belakang koma (contoh 4 digit di belakang koma
menjadi 5 digit di belakang koma) berarti jarak minimal 50 pips =5 pips pada platform normal.

Stop Loss or Take Profit you set must differ from market price by at least 50 pips.

Ilustrasi : Buy pada 1.50000 maka untuk TP 50 point tambahkan 500 atau 1.50500. Tips mudah untuk
menghitung level TP atau SL adalah dengan memasukkan pada kolom Level. Untuk TP 50 pada platform
normal, masukkan level 50 points. Untuk platform 5 digit masukkan Level 500 points. Lalu klik Copy as,
lalu klik Modify (merah).

New Order Fﬂ ] f’"é%é Cara mengaktifkan Trailing Stop pada Open Order:
% i ” " Klik Tab Trade, klik kanan mouse pada Open Order yang ingin anda

=4 Mocify or Delete Order

[_Eﬂ,ﬁw____ s 1 tambahkan Trailing Stop, pilih Trailing Stop, lalu pilih berapa point yang
Prft M None anda inginkan Trailing Stop mulai aktif.
_Symbols iT?: W Eiommissions .15\00?715 R
T | Untuk menambahkan jumlah point yang tidak ada dalam pilihan,

9727598 | v Ao hrange » =ems | Gjlahkan klik custom lalu set jumlah yang diinginkan.

v Grd G 55 points
&5 points

=os | Ingat fitur trailing stop hanya aktif jika komputer dan internet terhubung
»*= | dengan server. Pastikan komputer dan internet tetap ON.

2
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Setting satuan Profit/Loss

Size

Symbol

Price |

Profit

2009.02.10 19:05.

by stop

0.20

gbpusd 140212 1L 44422 1.47712 1.45832!

New Order F3 g
Close Order % '
EL  Mody or Delete Order L. g
Trailing Stop Lo
(o> < = ot J
o, zs Term Currenéf.\?
Commissions
ag Daposit f"J_ln'Efnw
Taxes
Comments
v Ao Amange Al || w
v (GAd G i;.e Type: Size

\__/__\ /.1 | _

Account History | MNews | Alerts | Mailbox | Experts: | Jpurmal |

y4es

Profit/Loss total dari open order aktif (dalam $)

- Klik kanan mouse pada Window Terminal Tab Trade. Setelah itu

. akan muncul window yang berhubungan dengan order, pilih
+Profit.

As Points : inenampilkan profit dalam satuan point.

As Term Currency : menampilkan profit dalam satuan Mata Uang
' wang ditradingkan

As Deposit Currency :
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Cara melakukan Delete atau Edit Pending Order aktif :

e " | Klik Tab Trade pada Window Terminal, klik kanan mouse pada pending order

| ummmm C&J yang akan didelete atau diedit

Trailing Stop *
Profit k
Symbals ! Tick | w  Commissions
i Order  / Taees
:[,; 19802694 Comments

[ 19802700 | v  Auto Amange A
b ' Grid

Klik kanan mouse pada pending order

S UL I LT

Delete Pending Order :

Setelah itu nampak window Order lalu
klik button Delete (kuning).

Untuk mengedit, silahkan lanjut ke Edit
Pending Order di bagian bawah

Take Profit:

L I’II'J ; Type: | odify Order o
[ffll\m I ‘ ||||1iEH "ﬂ ) in| R iy Orde:me —
lr lﬁ\ [ Jqll.h"”“ llj l| “ill l J Price: @
| .,-'\Ml‘yrw '\l ili‘ Illu ] P sl Stop Loss: @] Take Profit: IE
L‘ lrllwl]‘"ﬂj'yy U 1I4soar =0 !D AL 171 V|
ﬁ i | e L D
\WIK LU I 1Im15 Open price you set must differ from market price by atleast 50 pips.
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Order #19803389 sell stop 0.30 GBPUSD at 1.47500 sl: 1.49440 tp: 1.46000 3] Edit Pending Order :

Symbol: |5 und = US Ds Setelah itu nampak window Order lalu
148104 Volume: . . .
= ganti Price. Level Stop Loss / Take Profit
et | . | juga dapat anda ganti jika perlu, lalu
- Type: [Mody Order «| | Kklik button Modify (merah).

Ll Modify Order

e prices | 140000 8]

o Stoploss: | 0.00000 % TakeProfit: | 0.00000 3 |
. Expiry: i|:| 2005 v!

1.48037

= <I_ Modify ﬁ] ) [ Delete ]

Open price you set must differ from market price by atleast 50 pips.

1.48015

1.45004

PENTING :

Data , , dan tersimpan dalam server Broker, sehingga meskipun
komputer dan internet OFF (tidak terhtibung dengan server), order anda akan tetap tereksekusi secara
otomatis.

Sedangkan data Trailing Stop tersimpan dalam komputer client (anda), sehingga apabila komputer atau
internet mengaiami gangguan, maka trailing stop tidak berfungsi. Untuk mengatasi hal ini, selalu
gunakan stop ioss sebagai backup dari trailing stop.

Bagi trader yang trading secara otomatis menggunakan Expert Advisor (Robot Forex), sebagai contoh
http://www.belajarforexpro.com/expertadvisor.php, dapat melakukan langkah-langkah sebagai berikut :
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=>» Copy file Expert Advisor (misalnya super_hedging.ex4) ke dalam directory
MetaTrader4 (folder yang berwarna merah tidak harus MetaTrader4, tetapi
tergantung broker)

=» Apabila MetaTrader sedang berjalan, silahkan close lalu open kembali MetaTrader

T —

E-.::"j MetaTradesd

= Eﬂ] Accounts
o & 5395534 Belaja

| Server I _Chartts_ﬁi bbjeds_ﬁ- Tradé | Bxpert Advisors DEmail Il Publisher | -E\rerrts|

L&) 5462404 Belaja
E 31 Indicators

able Expert Advisors (sxcept for Custom Indicators and Scripts) ‘
=] Expert Advisors Disable experts when the profile has been changed ;

Digable experts when the account has been changed

by . %2 MACD Sample [ Alow ive trading

{ % Maving Average [ A=k manual corfimation
@3 Allow DLLimports
% Super_Hedging_ [ Corfim DLL function calls

g % Super_Hedging_
.. % test_broker
@ [%] custom Indicators
# £ Scripts [ oK ] [ Cancel ] [ Help

Allow extemal experts imports

=> Klik Tab Navigator, lalu klik tanda [+] untuk melihat list seluruh Expert Advisors. Bila anda telah
benar memasukkan file super_hedging.ex4, maka akan nampak super_hedging dengan warna
abu-abu di dalam List Expert Advisors. Jika tidak nampak, maka close MetaTrader, cek ulang
folder tempat anda mengcopy file Expert Advisor lalu open MetaTrader kembali.

=> Klik Ctri-O => Klik Tab Expert Advisors dan tick pada pilihan seperti gambar di atas. Lalu OK

=>» Untuk menjalankan Expert Advisor pada pair dan timeframe tertentu. Silahkan highlight Chart
yang diinginkan, sebagai contoh chart GBPUSD, M1.
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_ Chart yang sedang aktif adalah yang berwarna putih

0 Feb 15:37 10 Feb 15:43. 10 Feb 15:59 10 Feb 16:15 10

L | usbipy,mi5 (| GEPUSDM1 J EURCHF M15 |
- S

- T in Firrem L T

=> Klik 2x Expert Advisor atau drag EA ke chart yang sedang aktif. Ingat jangan berkali-kali
melakukan hal ini pada chart yang berbeda kecuali anda paham bahwa beberapa EA dapat
berjalan bersamaan tanpa menimbulkan konflik

=» Setelah melakukan langkah di atas, akan nampak Window sesuai nama Expert Advisor. Klik Tab
Inputs untuk mengganti setting Expert Advisor, klik 2x pada setting vang ingin diganti lalu klik OK
untuk menjalankan EA

e ———N R 1]
Comm06 Inputs |)
Vanable Walue :_‘
ab| Note =* SUPER HEDGING v1.66 =
-_a_l_f_"' MNote1 This Sepert Advisoris a copyright of
ah-g MNete2 Ftp:/Fwnary le amifarexpro.com
-_a_I_::_"' Moted hittp:/ fanvw beigjaforexpro com
ab | Moted =
st Made nomal
ab | Noeh  »<CLOSEALL POSITION — Load

Rrageac /\\ J —

lah] Metal

Jr/ﬂf H_ Cancel ][ Resst ]

Load : Untuk load setting Expert Advisor yang telah anda save. Sebagai contoh trader dapat
melakukan save setting EA khusus untuk News Non Farm Payroll, dlI
Save : Untuk save setting Expert Advisor sesuai preferensi trader
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Untuk mengatasi 2 masalah di atas, silahkan klik kanan mouse pada chart tersebut, ialu pilih
Expert Advisors => Remove.

Cek ulang setting Expert Advisor pada Ctrl-O => Tab
Teadeg a Expert Advisor.
| Expert Advisors ‘% Properties... Fi
[ Indicatorslis  Cilel |9 Remove [ |
. , i
Objects List Cirl+B ,_1;,_.; Sy Teder. 1B

Klik 2x Expert Advisor atau drag EA ke chart yang sedang aktif untuk mengaktifkan ulang EA.

Anda dapat menginstali iebih dari satu MetaTrader di PC yang sama. Cara ini umumnya digunakan
trader yang memiliki iebih dari 1 account dengan tujuan untuk menjalankan Robot Forex (Expert

Advisor) yang berbeda, strategi yang berbeda, ataupun membagi modal dalam beberapa account untuk
menghindari Margin Call yang bersamaan. (membagi resiko)

Langkah untuk menginstall lebih dari satu MetaTrader :

1) Ulangi langkah instalasi MetaTrader yang telah dijabarkan pada halaman 2, yaitu klik 2x pada file
setup MetaTrader. Lanjutkan hingga sampai pada langkah pemilihan folder :
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& MetaTrader 4.00 setup

MetaTrader 4 MetaTrader 4
Client Terminal Client Terminal
Select program group:
Select the destination folder wihere you wanl 1o install MetaTrades 4,00, To install to 5 dilfesent Mclalindess o |
location, chok Browse, and welect another foldes, Accessones ~|
ALCD Systems i
activePDF
Installation foldar Adrninistrative Tools
Adobe =
CAProgram Files\MetaTraded Browsze . Apache Friends
mpndartavol i vomiden, : Chnon 255
[:} Creative
Fucast Pro 4
FxDD - MetaTrader 4
FuPro 2 MetaTrader
FxPro MetaTrader
Gadwin 5 ystems b
I < Back I[ Head » I | Cancel ] [ < Back ]{_TIBKI> ] [ Cancel

2) Bedakan Folder MetaTrader yang kedua dengan folder sebelumnya misalnya folder yang lama :
C:\Program Files\MetaTrader4, ganti menjadi

3) Bedakan pula Program Group Metairader Baru dengan Program Group MetaTrader sebelumnya :
MetaTrader 4 ganti menjadi

TUTORIAL DAN PANDUAN FOREX

= Mendaftar Forex Real Account (Free) : http://www.belajarforexpro.com/broker.php

=>» Tutorial Dasar Trading Forex : http://www.belajarforexpro.com/panduanforex (PDF)

=>» Tutorial MetaTrader : http://www.belajarforexpro.com/panduanmt (PDF)

=>» Tutorial Memulai Trading di MetaTrader : http://www.belajarforexpro.com/tradeforex (PDF)
=>» Tutorial Instalasi VPS : http://www.belajarforexpro.com/vps (PDF)

=> Tutorial Pendaftaran Liberty Reserve : http://www.belajarforexpro.com/libertyreserve (PDF)
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=» Trading Forex Otomatis dengan Robot dan menghasilkan uang terus menerus di saat anda
tidur, berlibur, dll. http://www.belajarforexpro.com/expertadvisor.php
=>» Download Software PDF Reader untuk membaca file PDF : http://get.adobe.com/reader/

RECOMMENDED PARTNERS

=» LearnForexPro.com : Learn Forex Like A Pro (english) http://www.learnforexpro.com
=» FCMarket.com : Reliable Forex (Valas) Broker http://www.fcmarket.com
=» ProChanger.com : Exchanger E-Currency Terpercaya, Cepat, Murah http://www.prochanger.com

Untuk pertanyaan dan saran, silahkan email kami : support@belajarforexpro.com

-=SELAMAT BERTRADING DAN SEMOGA SUKSES=-
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